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USER GUIDE

SCC-C020 Isolated Current
Output Module

The SCC-CO20 is an isolated current output module that outputs up to
20 mA. The output current level is proportional to the voltage applied to
the module by an analog output channel of an E/M Series DAQ device.

Conventions

The following conventions are used in this guide:

<> Angle brackets that contain numbers separated by an ellipsis represent
a range of values associated with a bit or signal name—for example,
AO <3..0>.
» The » symbol leads you through nested menu items and dialog box options

to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

> &

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

é When symbol is marked on a product, it denotes a warning advising you to
take precautions to avoid electrical shock.

é When symbol is marked on a product, it denotes a component that may be
hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.
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italic

monospace

SC-2345

SCC

Ttalic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

SC-2345 refers to both the SC-2345 connector block and the SC-2345 with
configurable connectors.

SCC refers to any SCC Series signal conditioning module.

What You Need to Get Started

To set up and use the SCC-CO20, you need the following items:

U Hardware
—  SC-2345/2350 with one of the following:
*  SCC-PWRO1
e SCC-PWRO02 and the PSO1 power supply

*  SCC-PWRO03 (requires a 7 to 42 VDC power supply,
not included)

—  One or more SCC-CO20

—  68-pin E/M Series DAQ device
—  68-pin cable

—  Quick Reference Label

U Software
—  The latest version of NI-DAQmx

U Documentation
—  SCC-CO20 Isolated Current Output Module User Guide
- 8C-2345/2350 User Manual
—  SCC Quick Start Guide
—  Read Me First: Safety and Radio-Frequency Interference
—  Documentation for your hardware

—  Documentation for your software
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QO Tools
— 1/8 in. flathead screwdriver
— Numbers 1 and 2 Phillips screwdrivers

—  Wire insulation stripper

@ Note Software scaling of measurements is not supported on the Macintosh operating
system. Refer to the SCC-CO20 Module Pin Assignments section.

You can download NI documents from ni . com/manuals. To download
the latest version of NI-DAQmzx, click Download Software at ni . com.

Device Specific Information

E Note For general SCC module installation and signal connection information, and
information about the SC-2345/2350 carrier, refer to the SCC Quick Start Guide, available
for download at ni.com/manuals.

Installing the SCC-C020

A Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires.

Plug the SCC-CO020 into either SC-2345/2350 analog output socket
J(X+17), where X is 0 or 1. The SC-2345/2350 routes the voltage output of
E/M Series DAQ device analog output channel AO (X) to the SCC-CO20.

Connecting the SCC-C020 to a Load

@ Note The signal names have changed. Refer to ni.com/info and enter rdtntg
to confirm the signal names.

The screw terminals are labeled by pin number <1..3>. Pin 1 is the ground,
pin 2 is the current sink, and pin 3 is the isolated loop supply. Figure 1
shows how the ground, sink, and supply connect to the E/M Series DAQ
device.
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E/M Series
DAQ Device

SCC-C020

AO (X)

AO GND

15Viso

Figure 1. SCC-C020 Signal Connections to E/M Series DAQ Device

Using the Isolated Loop Supply of the SCC-C020

You can connect the SCC-CO20 to a load using either the isolated internal
loop supply or an external supply. The internal loop supply outputs a
voltage of 15 V with respect to the isolated ground reference. When using
the internal loop supply, the compliance voltage is 12.5 V. This allows for
a maximum load resistance of 625 Q at 20 mA. Figure 2 shows how to
connect the SCC-CO20, using the internal loop supply, to a nonreferenced

(floating) load and to a load with a high common-mode voltage.

SCC-C020

3 | SUPPLY

15 Viso

Load

SINK

SCC-C020
3 |SuPPLY
|
15V iso 0_2@ Load
2
SINK "

High
CcMV

Figure 2. Connecting the SCC-C020 Using the Internal Loop Supply

SCC-C020 Isolated Current Output Module

ni.com




@ Note If your load is grounded and you are using the internal supply, connect the load
ground to the current sink terminal at pin 2 on the SCC-CO20. Do not connect the load
ground to the isolated ground terminal because you could thereby defeat the isolation of
the module.

Driving Higher-Resistance Loads with the SCC-C020

In order to calculate the supply voltage your application requires, multiply
the load resistance by the current you need to sink, then add 2.5 V for the
voltage drop across the protection diode and the current-sink MOSFET.
If you need a higher voltage than the 15 V provided by the internal loop
supply, you can either add a second SCC-CO20 module or provide an
external loop supply.

Adding a Second SCC-C020 Module

You can add another SCC-CO20 loop supply to create a supply of 30 V,
as shown in Figure 3. Do not use more than two SCC-CO20 modules on
a single circuit, because the resulting voltage can cause overheating and
damage the modules and other equipment.
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SCC-C020

Load

SUPPLY
15Viso
ISO GND
SCC-C020
SUPPLY
15Viso
SINK I

Figure 3. Connecting Two SCC-C020 Modules to a Higher-Resistance Load
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Using an External Loop Supply

In order for the current sink to operate properly with an external loop
supply, the voltage must be within the range of 3 to 42 V. If the voltage is
too high, overheating can occur and damage the module. Figure 4 shows
four configurations using an external loop supply.

SCC-C0O20 SCC-C0O20
2 |SINK 2 |SINK
Load
0-20 mA 0-20 mA
Load
_1 |ISO GND 1 ]ISO GND
a. Nonreferenced load and external voltage supply (two circuits)
SCC-CO20 SCC-C0O20
2 |[SINK 2 |SINK
Load
0-20 mA 0-20 mA
Load
_1 |ISO GND _1 ]ISO GND
High High
CMV CMV
b. Referenced load and external voltage supply (two circuits)

Figure 4. Connecting the SCC-C020 Using an External Loop Supply

When you use an external loop supply, the order of the supply and load does
not matter as long as you do not create a second loop through which current
flows. If both the supply and the load are grounded, connect the signals as
shown in Figure 5.

© National Instruments Corporation 7 SCC-C020 Isolated Current Output Module



SCC-C020
2 |SINK

0-20 mA

1 [ISO GND

Load

V4

Figure 5. Connecting the SCC-C020 to a Grounded External Loop Supply
and a Grounded Load

For information about how to configure the SCC-CO20 module using
NI-DAQmx, refer to the SCC Quick Start Guide.

Calibrating Gain and Offset Errors

The SCC-CO20 is calibrated at the factory before shipment. If you want
to adjust the gain and offset of the SCC-CO20 in your system using an
E/M Series DAQ device, you need a current meter (ammeter) with an
accuracy of at least £2 pA.

To adjust the gain and offset of the SCC-CO20, complete the following
steps:

1. Disconnect the load from the SCC-CO20 you want to calibrate.

2. Set an output range of 0 to 10 V for AO (X), the E/M Series DAQ
device channel connected to the SCC-CO20.

3. Connect the negative lead of the ammeter to the current sink (pin 2)
and the positive lead to the current supply (pin 3) of the SCC-CO20.

4. Using your software, have AO (X) output 10 mVDC.

Adjust the offset potentiometer on the top of the SCC-CO20 until the
ammeter reads 20 pA. The offset is now calibrated.

6. Using your software, have AO (X) output 9 VDC.

7. Adjust the gain potentiometer on the top of the SCC-CO20 until the
ammeter reads 18 mA. The gain is now calibrated.
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E Note Normally you would adjust to O pA in order to calibrate the offset, but because
the SCC-CO20 cannot source current, it is impossible to know when you have adjusted
past 0 pA.

Using the SCC-C020

The SCC-CO20 is a 0 to 20 mA programmable current sink. The current
output is controlled by AO (X), a 0 to 10 V unipolar DAC output channel
of an E/M Series DAQ device. The relationship between the AO (X)
voltage level and the current output of the SCC-CO20 is linear and is
described by the following equation:

Viow _
500 C020

where
Vao x) is the AO (X) voltage level.
Ic029 1s the SCC-CO20 current output in amperes.
The current sink is an N-channel power MOSFET sink to an isolated

ground reference. You can use the SCC-CO20 with industry-standard
0 to 20 or 4 to 20 mA current loops.

@ Note The current sink does not source current. If the input voltage is O V or less,
the module sinks 0 mA.

Isolated Ground Reference

Each SCC-CO0O20 module is referenced to its own isolated ground. Each
isolated ground can have up to 60 VDC of common-mode voltage between
itself and any other channel ground or chassis ground. Refer to the
Connecting the SCC-CO?20 to a Load section for different ways to use
the isolated ground in signal connections.

Specifications

These ratings are typical at 25 °C unless otherwise stated.

Electrical
Number of output channels..................... 1
Output referencing .........cceceeceevereenennene Nonreferenced (floating)
INput range ......cooeevveevveeieeiierieeeeen Oto10V
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OULPUL TANZE ..cevvvenvreereeieeereeie e 0to 20 mA
Voltage compliance ...........ccccceeevverueennens 125V

Maximum load resistance

SIMA e 2,500 Q
TOMA o 1,250 Q
IS5 MA o 830 Q
20MA .o 625 Q
Absolute accuracy........ccocceevveeneeerieenieenns 0.1% of full-scale output range
Temperature drift...........cococeneniiiinnns 0.5 pA/°C typ
1 pA/°C max
Power Requirement
ANalog POWET ...c.evueeneerieiiniieienieeieniene 175 mW max
FISV e 5.8 mA max
—I5V 5.8 mA max
Digital power (+5 V) ..cocceeeniiceniniinee 645 mW
F5V 129 mA max
Physical
1.87 cm

! 7.93cm )
(3.12in.)

Figure 6. SCC-C020 Dimensions
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Weight ....oooiiiiiiiiieceeceeeee 28 g (1.0 0z)

I/O connectors..........cceeceeeeeeeeneineenncnnee. One 20-pin right-angle male
connector
One 3-pin screw terminal

Field-wiring diameter............cc.ccoceenuennee. 28to 16 AWG

Maximum Working Voltage

(Signal + common-mode) each input should remain within 42.4 V., or
60 VDC of ground.

Maximum working voltage refers to the signal voltage plus the CMV.

Channel-to-earth (inputs) .......cc.ccceeueeee. 42.4 Vpeq 01 60 VDC,
Measurement Category I

A Caution This device is rated for Measurement Category I and is intended to carry signal
voltages no greater than 42.4 V., or 60 VDC. Do not use this device for connection to
signals or for measurements within Categories II, I1I, or I'V.

Isolation Voltage

Channel-to-earth isolation

ContinuUOUS ......ccoeeeeeeeeeeeeeeenen 60 VDC,
Measurement Category I
Withstand .......cccceeveeniieniiinneeniennen. 2300 V¢ verifiedby a5 s

dielectric withstand test

Environmental
Operating temperature............ce.ceeeeeveenee. 0to 50 °C
Storage temperature ..........occeeveeeeruenneene —20to 70 °C
Humidity «o..ooevveenieniieiecieeeeeeeen 10 to 90% RH, noncondensing
Maximum altitude ..........ooovvvveveeeenanns 2,000 m
Pollution Degree (indoor use only)........ 2
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Safety

The SCC-CO20 is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:

« IEC61010-1, EN 61010-1
« UL 61010-1
e CAN/CSA-C22.2 No. 61010-1

@ Note For UL and other safety certifications, refer to the product label, or visit
ni.com/certification, search by model number or product line, and click the
appropriate link in the Certification column.

Electromagnetic Compatibility

EmiSSions.....c..eeeeeeiiuveeeeeeiiieeeeeeeiveeeeeenns EN 55011 Class A at 10 m
FCC Part 15A above 1 GHz

IMmMUNity ...oocooeeeieieeeeeeeeeee e EN 61326:1997 + A2:2001,
Table 1

EMC/EMI ...ccooovviiiiiiiiiiiiiieiieeieeeeeen CE, C-Tick, and FCC Part 15
(Class A) Compliant

@ Note For EMC compliance, operate this device with shielded cabling.

CE Compliance
The SCC-CO20 meets the essential requirements of applicable European

Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety).............. 73/23/EEC

Electromagnetic Compatibility
Directive (EMOC) ...cc.coevvevvceninincncnnnee 89/336/EEC

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit
ni.com/certification, search by model number or product line, and click the
appropriate link in the Certification column.
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SCC-C020 Module Pin Assignments

Figure 7 shows the I/O connector pins on the bottom of the module.

doooo0o0000 oM
Q000000000 ®
.4 \

1 Pin1 2 Pin2 3 PWB Key 4 Pin19 5 Pin 20

Figure 7. SCC-C020 Bottom View
Table 1 lists the signal connection corresponding to each pin.

Table 1. SCC-C020 Pin Signal Connections

Pin Number Signal
1 E/M Series AO (X)
2 E/M Series AO GND
3 —
4 E/M Series AO GND
5 —
6 —
7 —
8 —
9 +5V
10 GND
11 —
12 +5 V REF
13 +15V
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Table 1. SCC-C020 Pin Signal Connections (Continued)

Pin Number Signal

14 -15V
15 —
16 —
17 —
18 —
19 —
20 —

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.

Refer to the Terms of Use section on ni . com/legal for more information about National

Instruments trademarks. Other product and company names mentioned herein are trademarks or trade

names of their respective companies. For patents covering National Instruments products, refer to the

appropriate location: Help»Patents in your software, the patents . txt file on your CD, or

ni.com/patents.
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